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DISCLAIMER

The information contained in this document is for general informational purposes only and does

not constitute an offer, solicitation, invitation or recommendation to buy or sell any futures

contracts or other products or to provide any investment advice or service of any kind. This

document is not directed at, and is not intended for distribution to or use by, any person or entity

in any jurisdiction or country where such distribution or use would be contrary to law or regulation

or which would subject Hong Kong Exchanges and Clearing Limited (“HKEX”), Hong Kong

Futures Exchange Limited (“HKFE”) (together, the “Entities”, each an “Entity”), or any of their

affiliates, or any of the companies that they operate, to any registration requirement within such

jurisdiction or country.

No section or clause in this document may be regarded as creating any obligation on the part of

any of the Entities. Rights and obligations with regard to the trading, clearing and settlement of

any futures contracts effected on HKFE shall depend solely on the applicable rules of HKFE and

the relevant clearing house, as well as the applicable laws, rules and regulations of Hong Kong.

Although the information contained in this document is obtained or compiled from sources

believed to be reliable, neither of the Entities guarantees the accuracy, validity, timeliness or

completeness of the information or data for any particular purpose, and the Entities and the

companies that they operate shall not accept any responsibility for, or be liable for, errors,

omissions or other inaccuracies in the information or for the consequences thereof. The

information set out in this document is provided on an “as is” and “as available” basis and may

be amended or changed. It is not a substitute for professional advice which takes account of your

specific circumstances and nothing in this document constitutes legal advice. Neither of the

Entities shall be responsible or liable for any loss or damage, directly or indirectly, arising from

the use of or reliance upon any information provided in this document.

Additional disclaimer for CES China 120 Index Futures

CES China 120 Index (“CES 120 Index”) are calculated and / or disseminated by China

Securities Index Company Limited (“CSIC”) on behalf of China Exchanges Services Company

Limited (“CESC”). Neither CESC nor CSIC guarantee (expressly or impliedly) the accuracy,

completeness, timeliness or fitness for a particular purpose of the CESC Index and/or the

information contained therein; nor do they accept any liability for any damages, loss, costs or

expenses suffered by any person arising from the use of the CESC Index and/or the information

contained therein.

HKEX Pulse

Apple Store Google Play

Xiaomi 360

Futures and Options Information 

Application
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As at 31 January 2020

Data Source: Bloomberg

Information for reference only

Equity Indices Monthly Performance in

Sector Indices vs HSI / HSCEI CES120 vs China Theme Indices

Equity Index Futures Access Codes
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As at 31 January 2020

Data Source: HKEX

* OI compared to previous year-end

Information for reference only

Equity Index Futures & Options

HSI Futures (YoY) HSI Options (YoY)

HSI Futures (MoM) HSI Options (MoM)

Hang Seng Index (HSI) Futures & Options

HSI Products 

(2020 vs 2019)
ADV OI*

HSI Futures 186,425 (-11%) 131,060 (+8%)

Mini-HSI Futures 87,078 (-3%) 11,490 (+8%)

HSI Options 52,565 (+4%) 246,408 (+17%)

Mini-HSI Options 14,334 (+5%) 22,606 (+26%)

HSI Volatility 

Index Futures
3 (+200%) 22 (+340%)

HSI Dividend 

Point Index 

Futures

99 (+77%) 2,430 (+28%)
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As at 31 January 2020

Data Source: HKEX, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference only

Equity Index Futures & Options

HSI Futures & Options

HSI & Top 5 Constituents

Distribution of HSI Index Options OI in Month-end

Hang Seng Index

 Includes the largest and most 

 liquid stocks listed in Hong Kong

 Index Level  26,312.63 (As at 31 Jan 2020)

 Index Volatility (30-Day Historical)  18.0

 Index Avg. Day High-Low Range  296.11 (Jan 2020)

 HSCEI Correlation (2019)  0.951

 Contract Multiplier  HK$50

 Notional Value (1 Contract)  HK$1.32Mn (As at 31 Jan 2020)

Transaction Cost*

Stamp Duty  N/A

Trading Fee  HK$10 / contract

SFC Levy  HK$0.54 / contract

Commission Rate  Negotiable

Margin as of 02 Dec 2019  HK$79,350

Hang Seng Index Futures

 Index Description

12

14

16

18

20

22

24

25

26

27

28

29

Nov-19 Dec-19 Jan-20

('000)

HSI VHSI

88

94

100

106

112

118

124

130

136

Nov-19 Dec-19 Jan-20

HSI Index Tencent

HSBC AIA

CCB China Mobile

0 2 4 6 8 10

19.6

21.2

23.2

25.2

27.2

29.2

31.2

33.2

35.2

37.2

40.0

Open Interest ('000)

In
d
e
x
 S

tr
ik

e
 P

ri
c
e
 (

'0
0
0
)

Call

0 4 8 12 16 20

10.0

19.6

21.2

23.2

25.2

27.2

29.2

31.2

33.2

35.2

37.2

40.0

Open Interest ('000)

In
d
e
x
 S

tr
ik

e
 P

ri
c
e
 (

'0
0
0
)

Put

HSI vs VHSI Price Level 



66

As at 31 January 2020

Data Source: HKEX

* OI compared to previous year-end

Information for reference only

Equity Index Futures & Options

HSCEI Futures (YoY) HSCEI Options (YoY)

HSCEI Futures (MoM) HSCEI Options (MoM)

Hang Seng China Enterprises Index (HSCEI) Futures & Options

HSCEI Products 

(2020 vs 2019)
ADV OI*

HSCEI Futures 143,877 (+4%) 362,141 (+11%)

Mini HSCEI 

Futures
12,746 (-15%) 5,861 (+39%)

HSCEI Options 89,986 (+3%) 2,270,319 (+9%)

Mini HSCEI 

Options
2,386 (+1%) 13,023 (+2%)

HSCEI Dividend 

Point Index 

Futures

3,420 (+58%) 117,526 (+1%)
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As at 31 January 2020

Data Source: HKEX, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference only

Equity Index Futures & Options

HSCEI Futures & Options

HSCEI & Top 5 Constituents
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HSCEI

Comprises the largest and 

most liquid H shares

 Index Level  10,240.51 (As at 31 Jan 2020)

 Index Volatility (30-Day Historical)  18.2

 Index Avg. Day High-Low Range  135.55 (Jan 2020)

 Correlation with HSI, CES120 (2019)  0.951,0.899

 Correlation with CSI300, FTSE A50

 (2019)
 0.744,0.765

 Contract Multiplier HK$50

 Notional Value (1 Contract)  HK$0.51Mn (As at 31 Jan 2020)

Transaction Cost*

Stamp Duty  N/A

Trading Fee  HK$3.5 / contract

SFC Levy  HK$0.54 / contract

Commission Rate  Negotiable

Margin as of 02 Dec 2019  HK$31,400

HSCEI Futures

 Index Description

HSI vs HSCEI 

Distribution of HSCEI Index Options OI in Month-end
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As at 31 January 2020

Weekly HSI & HSCEI Options Performance

Data Source: HKEX

* All calculations are in HKD and exclude commission fees

Information for reference only

An investment tool to manage short term event risk

Weekly HSI & HSCEI Options Volume

Contract Multiplier  HK$50

Liquidity Providers  Akuna, Eclipse, I-Access, IMC, Optiver

Transaction Cost*

Stamp Duty  N/A

Trading Fee  HK$10 / contract

SFC Levy  HK$0.54 / contract

Commission Rate  Negotiable

Contract Multiplier  HK$50

Liquidity Providers  Akuna, Eclipse, I-Access, IMC, Optiver

Transaction Cost*

Stamp Duty  N/A

Trading Fee  HK$3.5 / contract

SFC Levy  HK$0.54 / contract

Commission Rate  Negotiable

Weekly HSI Options

Weekly HSCEI Options
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As at 31 January 2020

Data Source: HKEX

* OI compared to previous year-end

Information for reference only

Equity Futures & Options

Single Stock Futures & Options

Stock Options (YoY)Stock Futures (YoY)

No. of Single Stock Derivatives

Single Stock Futures 80

Single Stock Options 96

Stock Futures

• Products

 3 A-shares ETFs futures contracts

 Total 80 stock futures contracts

Latest and Future Developments

Stock Options

• Products

 3 A-shares ETFs options contracts

 Total 96 stock options contracts

• Market Makers (MMs)

 3 types of market makers (PMM/ CQMM/ 

QRMM)

 CQMM to provide 50 series continuous 

quotations

Stock Futures (MoM) Stock Options (MoM)
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Single Stock Derivatives ADV (2020 vs 2019) ADV OI*

Stock Futures 4,370 (+17%) 20,272 (-26%)

Stock Options 523,431 (+18%) 8,054,819 (+20%)
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As at 31 January 2020

MSCI AC Asia ex Japan NTR Index (AxJ) Futures Performance

Data Source: HKEX, Bloomberg

* All calculations are in US$ and exclude commission fees

Information for reference only

MSCI AxJ Combines Developed and Emerging Markets (Rebased  to 100)

Open Interest continues to develop

MSCI AxJ is a well-established benchmark representing Asia 

regional (excluding Japan) equity market performance
Futures contracts have relatively lower transaction costs
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 MSCI AxJ

representation 2 DM countries (excl. Japan)

and 9 EM countries in Asia

 Index Level  486.76 (As at 31 January 2020)

 Index Volatility (30-Day Historical)  14.5

 Index Avg. Day High-Low Range  4.58 (January 2020)

 HSI Correlation (2019)  0.953

 HSCEI Correlation (2019)  0.931

 Contract Multiplier  US$100

 Notional Value (1 Contract)  US$49K (As at 31 January 2020)

 Avg. Quote Size  US$0.24Mn (5 Contracts)

 Avg. Bid-Ask Trading Spread  0.0 index points (January 2020)

 Liquidity Providers Flow  and 11 banks

Stamp Duty  N/A

Trading Fee  US$0.5 / contract

SFC Levy  US$0.07 / contract

Margin as of 02 Jan 2020  US$1,730

 Transaction Cost*

 MSCI AxJ Futures

 Index Description
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As at 31 January 2020

Hang Seng Mainland Banks Index Futures Performance

Data Source: HKEX, HSIL, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference only

Index & Constituents 3-Month Performance (Rebased to 100)

HSMBI Futures have relatively moderate Bid-Ask Spreads

HSMBI Futures can be used for hedging3Futures contracts have relatively lower transaction costs

1

2

 Hang Seng Mainland Banks Index (HSMBI)

 10 largest and most representative 

 HKEX-listed mainland banks stocks

 Index Level  2,789.74 (As at 31 January 2020)

 Index Volatility (30-Day Historical)  18.0

 Index Avg. Day High-Low Range  29.90 (January 2020)

 HSI Correlation (2019)  0.971

 HSCEI Correlation (2019)  0.97

 Contract Multiplier  HK$50

 Notional Value (1 Contract)  HK$0.14Mn (As at 31 January 2020)

 Avg. Quote Size  HK$0.70Mn (5 Contracts)

 Avg. Bid-Ask Trading Spread  0.0 index points (January 2020)

 Liquidity Providers Flow , IMC, Yue Kun

Stamp Duty  N/A

Trading Fee  HK$2 / contract

SFC Levy  HK$0.54 / contract

Margin as of 02 Jan 2020  HK$7,740

Transaction Cost*

 Hang Seng Mainland Banks Index Futures

 Index Description
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HSMBI Futures
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As at 31 January 2020

Hang Seng Mainland Oil & Gas Index Futures Performance

Data Source: HKEX, HSIL, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference only

Index & Constituents 3-Month Performance (Rebased to 100)

HSMOGI Futures have relatively moderate Bid-Ask Spreads1

HSMOGI Futures can be used for hedgingFutures contracts have relatively lower transaction costs2 3

 Hang Seng Mainland Oil & Gas Index (HSMOGI)

 7 largest and most representative 

 HKEX-listed mainland oil & gas stocks

 Index Level  1,508.27 (As at 31 January 2020)

 Index Volatility (30-Day Historical)  21.9

 Index Avg. Day High-Low Range  20.54 (January 2020)

 HSI Correlation (2019)  0.676

 HSCEI Correlation (2019)  0.69

 Contract Multiplier  HK$50

 Notional Value (1 Contract)  HK$75K (As at 31 January 2020)

 Avg. Quote Size  HK$0.38Mn (5 Contracts)

 Avg. Bid-Ask Trading Spread  0.0 index points (January 2020)

 Liquidity Providers  Flow , IMC, Yue Kun

Stamp Duty  N/A

Trading Fee  HK$2 / contract

SFC Levy  HK$0.54 / contract

Margin as of 02 Jan 2020  HK$4,080

Transaction Cost*

 Hang Seng Mainland Oil & Gas Index Futures

 Index Description

0.25%

0.26%
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0.39%

0.60%

1.65%

Sinopec Corp 386.HK

CNOOC 883.HK
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Kunlun Energy 135.HK

HSMOGI Futures

BG Blue Sky 6828.HK
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As at 31 January 2020

Hang Seng Mainland Properties Index Futures Performance

Data Source: HKEX, HSIL, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference only

Index & Constituents 3-Month Performance (Rebased to 100)

HSMPI Futures have relatively tighter Bid-Ask Spreads

HSMPI Futures can be used for hedgingFutures contracts have relatively lower transaction costs

1

2 3

 Hang Seng Mainland Properties Index (HSMPI)

 10 largest and most representative 

 HKEX-listed mainland properties stocks

 Index Level  6,663.80 (As at 31 January 2020)

 Index Volatility (30-Day Historical)  30.0

 Index Avg. Day High-Low Range  116.42 (January 2020)

 HSI Correlation (2019)  0.816

 HSCEI Correlation (2019)  0.815

 Contract Multiplier  HK$50

 Notional Value (1 Contract)  HK$0.33Mn (As at 31 January 2020)

 Avg. Quote Size  HK$1.7Mn (5 Contracts)

 Avg. Bid-Ask Trading Spread  0.0 index points (January 2020)

 Liquidity Providers  Flow , IMC, Yue Kun

Stamp Duty  N/A

Trading Fee  HK$2 / contract

SFC Levy  HK$0.54 / contract

Margin as of 02 Jan 2020  HK$22,520

Transaction Cost*

 Hang Seng Mainland Properties Index Futures

 Index Description
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0.21%
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1.38%

HSMPI Futures
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Sino-Ocean Gp 3377.HK
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Fullshare 607.HK
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0.11%

0.15%

0.15%

0.15%

CES120 Futures

X iShares A50 ETF (2823.HK)

ChinaAMC CSI300 ETF (3188.HK)

CSOP FTSE A50 ETF (2822.HK)

As at 31 January 2020

Data Source: HKEX, HSIL, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference only

CES120 & Top Constituents’ 3-Month Performance

(Rebased to 100)

CES120 Futures have relatively tighter Bid-Ask Spreads

CES120 Index Futures Performance

Futures contracts have relatively lower transaction costs CES120 Futures can be used to hedge A-share positions

1

32

5-Min Avg. Bid-Ask Spreads (31 January 2020)
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CES120 Index Tencent CCB

Ping An China Mobile

 CES120 Index

 80 A-Shares and 40 HK-listed Mainland

 China H-shares, P-chips, and red chips

 Index Level  6,773.77 (As at 31 January 2020)

 Index Volatility (30-Day Historical)  18.1

 Index Avg. Day High-Low Range  67.87 (January 2020)

 CSI300 Correlation (2019)  0.955

 FTSE A50 Correlation (2019)  0.969

 Contract Multiplier  HK$50

 Notional Value (1 Contract)  HK$0.34Mn (As at 31 January 2020)

 Average Quote Size  HK$1.69Mn (5 Contracts)

 Average Bid-Ask Trading Spread  0.0 index points (January 2020)

 Liquidity Providers  Flow

Stamp Duty  N/A

Trading Fee  HK$5 / contract

SFC Levy  HK$0.54 / contract

Margin as of 02 Jan 2020  HK$17,750

 CES120 Index Futures

 Index Description

Transaction Cost*
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Weekly HSI and HSCEI Options Access Codes

Information Vendor Weekly HSI Options Weekly HSCEI Options

AASTOCKS 322105 322125

Bloomberg HSI Index OMON HSCEI Index OMON

DB Power HSI HHI

ET Net Limited Menu "Futures/Options" > "Futures/Options Quotation (Short-term)“ > Access code: The series name

Infocast HSI HHI

MegaHub Limited HSI HHI

N2N-AFE 873101 873121

Refinitiv <0#HSIW*.HF> <0#HCEIW*.HF>

Tele-Trend File->Open->Options->HSI File->Open->Options->HHI

Hong Kong and International Information Vendors

Data Source: HKEX

MSCI AxJ and MSCI AxJ Futures Access Codes

Information Vendor MSCI AxJ Index MSCI AxJ Index Futures

AASTOCKS - 221495

Activ Financial - MXJ/<yy><m>.HF

Bloomberg M1ASJ Index MJSA Index CT

CQG - MXJ

DB Power - MXJ

East Money Information - MXJ

Factset - MXJE

ICE Data Services - F:MXJ

Infocast - MXJ

N2N-AFE - 870823

QPWeb - P11203

SIX Financial Information - MXJmy

Thomas Reuters .MIAX00000NUS 0#HMXJ:

Telequote Data - MXJ/<yy><m>.HF

Tele-Trend - MXJFC, MXJmyy

Hong Kong and International Information Vendors
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Sector Index and Sector Index Futures Access Codes

Information Vendor Mainland Banks 

Index

Mainland Banks 

Index Futures

Mainland 

Properties 

Index

Mainland 

Properties Index 

Futures

Mainland Oil 

& Gas Index

Mainland Oil & 

Gas Index 

Futures

AASTOCKS 221420 221425 221415

Activ Financial =0200700.HK MBI/16K.HF =0200800.HK MPI/16K.HF =0201000.HK MOI/16K.HF

AFE 837451 870809 837451 870810 837451 870808

Bloomberg HSMBI Index BMWA Index MSMPI Index PPTA Index HSMOGI Index OGIA Index

DB Power MBI MPI MOI

ET Net MBN MBI MPR MPI MOG MOI

Infocast HSMBI MBI MSMPI MPI MOGI MOI

QuotePower SEHK.HHSMBI P11223 SEHK.HHSMPI P11224
SEHK.HHSMO

GI
P11222

Telequote MBImy MPImy MOImy

Thomson Reuters .HSMBI 0#HMBI: .HSMPI 0#HMPI: .HSMOGI 0#HMOI:

Hong Kong and International Information Vendors

Mainland Information Vendors

Data Source: HKEX

Information Vendor Mainland Banks 

Index

Mainland Banks 

Index Futures

Mainland 

Properties Index

Mainland 

Properties Index 

Futures

Mainland Oil 

& Gas Index

Mainland Oil & 

Gas Index 

Futures

East Money HSMBI MBI HSMPI MPI HSMOGI MOI

Hexin Flush Financial MBIC MPIC MOIC

Pobo Financial
MBI+Month+Ye

ar
MPI+Month+Year

MOI+Month+Ye

ar

Qianlong 999905 209 999902 209 999903 209

Wind HSMBI
MBIF+yymm+H

K
HSMPI MPIF+yymm+HK HSMOGI

MOIF+yymm+H

K
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CES120 Index and CES120 Index Futures Access Codes

Information Vendor CES 120 Index CES 120 Index Futures

Bloomberg Finance L.P. CES120 CESA Index DES <GO>

Thomson Reuters .HKCES120 0#HCHH:

AAStocks.com Limited 110056 221360

AFE Solutions Ltd. 837505 870800

DB Power Online Limited CES120 CHH

ET Net Limited CEC CHH

Infocast Limited CE120 CHH

Interactive Data Group I:CES120 Fn:CHH\MYYDD

Marketprizm Hong Kong Limited CES120 CHHmy

SIX Financial Information Ltd. CES120 CHHmy

Telequote Data International Limited CES120 CHHmy

Hong Kong and International Information Vendors

Mainland Information Vendors

Data Source: HKEX

Information Vendor CES 120 Index CES 120 Index Futures

Hithink RoyalFlush Information Network Ltd CES120 CHHC

Shangahai DZH Limited CES120 CHH+Month Code+Year Code

Shanghai Gildata Services Co Ltd CES120 -

Shanghai Wind Information Co., Ltd CES120 CHHF+yymm+.HK

Zheng Zhou Esunny Information Technology Co, 

Ltd.
- CHH

Shanghai Wenhua Financial Information Ltd - CHHmy

Shanghai Qianlong Advanced Technology Co Ltd CES120 Page 209


